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คำนำ 

หนังสือเล่มนี้จัดทำข้ึนเพื่อใช้ประกอบการเรียนการสอนในรายวิชาสถิติและการออกแบบการทดลอง
เชิงวิศวกรรม และรายวิชาการควบคุมคุณภาพ ในหลักสูตรวิศวกรรมศาสตรบัณฑิต สาขาวิชาวิศวกรรมอุตสา
หการ มหาวิทยาลัยนครพนม ซึ่งรายวิชาดังกล่าวเน้นด้านทฤษฎีที่เข้าใจได้ยาก การนำโปรแกรม Minitab มา
ประกอบจะทำให้เข้าใจได้ดียิ่งขึ้น เนื้อหาในหนังสือเล่มนี้จะมุ่งเน้นในการยกตัวอย่างและประยุกต์ใช้โปรแกรม 
Minitab กับการควบคุมและปรับปรุงคุณภาพในงานด้านอุตสาหกรรมเป็นหลัก อย่างไรก็ตาม ผู้เขียนเชื่อว่า
เนื้อหาในหนังสือเล่มนี้ยังสามารถนำไปประยุกต์ใช้กับงานด้านอื่น ๆ ที่ต้องมีการวิเคราะห์ด้านสถิติได้ 

หนังสือเล่มนี้ประกอบด้วยเนื้อหาทั้งหมด 10 บท เรียงตามข้ันตอนในการจัดการคุณภาพด้วยเทคนิค 
Sig Sigma ที่เรียกว่า DMAIC ซึ่งมีขั้นตอนดังนี้  

1) Define คือ การระบุสภาพปัญหาและความเสียหาย โดยใช้เครื่องมือคุณภาพในบทที่ 2 
2) Measure คือ การวัดระดับของกระบวนการในปัจจุบัน ประกอบด้วยบทที่ 3 การวิเคราะห์ระบบ

การวัด และบทที่ 4 การวิเคราะห์ความสามารถของกระบวนการ 
3) Analyze คือ วิเคราะห์ข้อมูลเพื่อหาความสัมพันธ์ระหว่างสาเหตุและผลลัพธ์เพื่อหาสาเหตุที่

แท้จริง ประกอบด้วย บทที่ 5 การทดสอบสมมติฐาน บทที่ 6 การวิเคราะห์ความแปรปรวน บทที่ 
7 การวิเคราะห์สหสัมพันธ์และการถดถอย และบทที่ 8 การวิเคราะห์อนุกรมเวลาและการ
พยากรณ์ 

4) Improve คือ การปรับปรุงประสิทธิภาพของกระบวนการโดยการออกแบบการทดลองในบทที่ 9 
5) Control คือ การควบคุมกระบวนการที่ได้รับการปรบัปรุงให้อยู่ภายใต้การควบคุมอย่างสม่ำเสมอ

โดยใช้แผนภูมิควบคุมในบทที่ 10 

จุดเด่นของหนังสือเล่มนี้ คือ การยกตัวอย่างปัญหาแล้วอธิบายการใช้คำสั่ง โปรแกรม Minitab เป็น
ขั้นตอนพร้อมภาพประกอบ ผลการรัน ตาราง กราฟ และอธิบายผลการวิเคราะห์ที่ได้จากโปรแกรม เพื่อให้
ผู้อ่านสามารถศึกษาเข้าใจได้ด้วยตัวเองและสามารถนำไปประยุกต์ใช้กับปัญหาอื่น ๆ ที่คล้ายกันได้  

สุดท้ายนี้ ขอขอบคุณบริษัทโชลูช่ัน เซ็นเตอร์ จำกัด ตัวแทน Minitab ในประเทศไทยที่อนุญาตในการ
จัดทำและเผยแพร่หนังสือโดยใช้โปรแกรม Minitab หวังเป็นอย่างยิ่งว่าหนังสือเล่มนี้จะได้รับการตอบรับจาก
ผู้อ่าน เพื่อเป็นกำลังใจในการสร้างสรรค์หนังสือเล่มต่อ ๆ ไป  

 

ผู้ช่วยศาสตราจารย์ ดร.เฉลิมชาติ  ธีระวิริยะ 
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บทที่ 1 บทนำ 
 

 โปรแกรม Minitab เป็นโปรแกรมที่ใช้วิเคราะห์ และประมวลผลทางด้านสถิติที่มีความโดดเด่นในด้าน
การใช้งานที่ง่าย มีความเที่ยงตรงและแม่นยำในการประมวลผลข้อมูลสูง อีกทั้งสามารถใช้กับระบบปฏิบัติการ
วินโดวส์ได้ Minitab จึงเป็นโปรแกรมที่มีความโดดเด่นในด้านการใช้งานที ่ง ่ายและสามารถทำงานได้
หลากหลาย ทั้งการวิเคราะห์ข้อมูลทางสถิติ การออกแบบการทดลอง การสร้างเครื่องมือคุณภาพ การวัด
สมรรถนะของกระบวนการ Minitab จึงได้รับการยอมรับจากผู้ใช้งานในหลายภาคส่วน เช่น นักวิเคราะห์ทาง
สถิติ นักวิจัย นักศึกษา วิศวกรในโรงงานอุตสาหกรรม เป็นต้น Minitab ถูกคิดค้นขึ ้นโดยนักวิจัยชาว
สหรัฐอเมริกาชื่อ Barbara F. Ryan, Thomas A. Ryan, Jr, and Brain L. Joiner เมื่อปี 1972 และได้มีการ
พัฒนาปรับปรุงฟังก์ชันต่าง ๆ อย่างต่อเนื่องเป็นเวลานานถึง 40 กว่าปี 

 แม้ว่าโปรแกรม Minitab จะช่วยให้เราวิเคราะห์ข้อมูลต่าง ๆ ได้อย่างสะดวก รวดเร็วขึ้นมาก แต่
ความรู้ความเข้าใจในการทำงานของโปรแกรมก็เป็นส่วนสำคัญที่จะทำให้เราใช้งานโปรแกรมได้อย่างเต็ม
ประสิทธิภาพมากขึ้น ในบทนี้จะเป็นการอธิบายภาพรวมและการทำงานของโปรแกรมโดยทั่วไป โดยโปรแกรม 
Minitab ที่นำมาใช้ในหนังสือเล่มนี้คือรุ่นที่ 19 

1.1 เริ่มใช้งานโปรแกรม Minitab 

 เมื่อเปิดโปรแกรม Minitab ข้ึนมา จะพบกับส่วนประกอบหลักของหน้าจอ ดังรูป 

 

 

 

 

 

 

 

 

 

5. Main menu bar 

1. Navigator 
4. Command/History 

pane 

3. Data pane 

2. Output pane 
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1. หน้าต่างรายการผลลัพธ์ (Navigator) 

ประกอบด้วยรายการหัวข้อผลลัพธ์ที่อยู่ในแฟ้มงานของคุณโดยเรียงลำดับตามลำดับการใช้คำสั่งโดย
หัวข้อล่าสุดจะอยู่ท้ายสุดของรายการ คลิกเมาส์ปุ่มขวาที่หัวข้อผลลพัธ์ใด ๆ บนหน้าต่างรายการผลลัพธ์เพือ่ทำ
สิ่งเหล่านี ้

- เปิดผลลัพธ์แยกหน้าต่างเพื่อเปรียบเทียบผลลัพธ์แยกแท็บ 
- เปลี่ยนชื่อหัวข้อผลลัพธ์เมื่อทำการเปลี่ยนช่ือ หัวข้อผลลัพธ์ที่หน้าต่างผลลัพธ์ ชื่อหัวข้อก็จะ

เปลี่ยนตามด้วย 
- ส่งผลลัพธ์ไปยังโปรแกรมอื่น เช่น Microsoft Word หรือ PowerPoint เป็นต้น 
- ลบการวิเคราะห์ออกจากแฟ้มงาน และสามารถเรียกคืนการลบไดโ้ดยไปยังเมนู Edit เลือก Undo 

 
2. หน้าต่างผลลัพธ์ (Output pane) 

แสดงผลลัพธ์ เช่น กราฟและตาราง หลังจากใช้ชุดคําสั่งวิเคราะห์ ผลลัพธ์ของแต่ละการวิเคราะห์
แสดงแยกแตล่ะแท็บ 

3. หน้าต่างข้อมูล / เวิร์กชีต  (Data Pane) 

แสดงเวิร์กชีตที่เลือก สามารถเปิดหลายๆเวิร์กชีตในหน้าต่างข้อมูลพรอ้ม ๆ  กัน แต่ Minitab ใช้ข้อมูล
ในเวิร์กชีตที่เลือกในการวิเคราะห์ ในการเปลี่ยนช่ือเวิร์กชีตให้ดับเบิลคลิกที่ช่ือบนแท็บเวิร์กชีต  

4. หน้าต่างรายการชุดคำสั่ง (Command/History Pane) 

ค่าเริ่มต้นหน้าต่างนี้จะไมแ่สดง เพื่อที่จะแสดงหน้าต่างนีใ้ห้เลือก View > Command Line/History 
หน้าต่างนีจ้ะแสดงในครั้งต่อไปเมื่อเราเปิดโปรแกรม Minitab 

5. แถบเมนูหลัก (Main menu bar) 

เป็นแถบที่รวมฟังก์ชันที่สำคัญต่าง ๆ ในการใช้งาน เมื่อคลิกเลือกที่เมนูหลัก ก็จะพบกับเมนูย่อยที่ซ้อนอยู่
อีกที 

1.2 การกรอกข้อมูล 

ผู้ใช้งานสามารถป้อนข้อมูลลงในเวิร์กชีตได้โดยการป้อนผ่านแป้นคีย์บอร์ดของคอมพิวเตอร์ 

ตัวอย่างที่ 1.1 กรอกข้อมูลปริมาณของเสียที่เกิดขึ้นในโรงงานผลิตชิ้นส่วนรถยนต์แห่งหนึ่ง โดยแยกตาม
กระบวนการผลิตทั้ง 4 กระบวนการ จากการทำงาน 5 วันที่ผ่านมา (Minitab project: Defect no) 
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ลูกศรชี้ลงแสดงว่าเมื ่อป้อนข้อมูลในเซลล์เสร็จแล้วกด Enter เคอร์เซอร์จะเลื่อนลงมาที่
ตำแหน่งเซลล์ด้านล่าง เมื่อคลิกที่ลูกศร 1 ครั้ง หัวลูกศรจะช้ีไปทางขวาแสดงว่าเคอร์เซอร์จะเลื่อนไป
เซลล์ด้านขวาเมื่อกด Enter 

ประเภทข้อมูล 

เวิร์กชีตใน Minitab จะรับข้อมูลได้ 3 ประเภท คือ 

1. Numeric data ข้อมูลประเภทตัวเลขทั้งจำนวนเต็มและทศนิยม ตัวอย่างเช่น 35 หรือ 8.9271 
2. Text data ข้อมูลตัวอักษร ตัวเลข ช่องว่างและอักขระ ตัวอย่างเช่น Department 5 หรือ East Asia 
3. Date/time data ข้อมูลวันที่ ตัวอย่างเช่น Mar-17-2020, 17-Mar-2020, 3/17/20, หรือ 17/03/20

ข้อมูลเวลา ตัวอย่างเช่น 08:25:22 AM ข้อมูลประเภทวันที่และเวลา 3/17/20 08:25:22 AM หรือ 
17/03/20 08:25:22 

จากตัวอย่างที่ 1.1 ค่าเริ่มต้นของคอลัมน์จะเป็น C1, C2,…, แต่เมื่อเรากรอกข้อมูลเข้าไปแล้ว ค่านี้จะ
แสดงประเภทของข้อมูล เช่น C1-T คือข้อมูลตัวอักษร, C2-D คือข้อมูลวันที่ เป็นต้น ส่วนด้านล่างของ
คอลัมน์ดังกล่าว เราสามารถตั้งช่ือให้กับข้อมูลที่อยู่ในคอลัมน์นั้นได้ เช่น คอลัมน์ C1 ช่ือ “Department” 
เป็นต้น 

1.3 การบันทึกข้อมูล 

คลิกที่เมนู file จะเจอเมนูที่ซ่อนอยู่ดังรูป 

 

 

 

 

Save Project: ใช้ในการบันทึกข้อมูล

ทั้งหมด เช่น เวิร์กชีตทุกแผ่น ผลการ

ประมวลผล กราฟ รายละเอียด ใน 

session window 

Save worksheet: ใช ้ ในการบ ันทึ ก

ข้อมูลที่อยู่ในเวิร์กชีตเท่าน้ัน 
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1.4 การเข้าถึงข้อมูล 

คลิกที่เมนู file จะเจอเมนูที่ซ่อนอยู่ดังรูป 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.5 การดำเนินการกับข้อมูล 

• การคำนวณข้อมูล 

จากตัวอย่างที่ 1.1 หากเราต้องการทราบผลรวมของจำนวนของเสียที่เกิดขึ้นทั้ง 5 วัน การคำนวณค่าตัว
เลขที่อยู่ในเซลล์ทำได้โดยเข้าไปที่เมนู Calc > Calculator จะปรากฏหน้าจอดังรูป 

• คลิก New เมื่อต้องการสร้าง 

Project หรือ worksheet 

ใหม่ 

• คลิก Open เพื่อเปิด 

Project หรือ 

worksheet ที่บันทึกเก็บ

ไว้ในคอมพิวเตอร์ 
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คลิก OK ผลลัพธ์ที่ได้จากโปรแกรม 
 
 
 
 
 
 
 
 
จะพบว่าคอลัมน์ C8 (Total) แสดงผลการคำนวณผลรวมของจำนวนของเสียที่เกิดข้ึนทั้ง 5 วัน 
 

• การแทรก-ลบ คอลัมน์-แถว 

- การลบคอลมัน ์ คลิกทีห่ัวคอลัมน์ (C1, C2,…,) จากนั้นกด [Del] ที่แป้นคีย์บอร์ด 
- การลบแถว  คลิกทีห่มายเลขแถว (1, 2,…,) จากนั้นกด [Del] ที่แป้นคีย์บอร์ด 
- การแทรกแถว คลิกทีห่มายเลขแถวที่ต้องการแทรก จากนั้นกดไอคอน Insert Row ทีเ่มนู

บาร ์
 

 

คอลัมน์ที่มีข้อมูลอยู่ 

สูตรการคำนวณ 

ตั้งชื่อคอลัมน์ที่ต้องการให้ผลลัพธ์แสดงผล 



6 

 

การวิเคราะห์ข้อมูลสถิติด้วยโปรแกรม Minitab  ผศ.ดร.เฉลิมชาติ ธีระวิริยะ 

- การแทรกคอลมัน ์ คลิกทีห่ัวคอลัมนท์ี่ต้องการจะแทรก จากนั้นกดไอคอน Insert Column 

ที่เมนบูาร ์

 

 

 

 

• การจัดข้อมูลแบบเรียงต่อกัน 

ปกติแล้วคอลัมน์หนึ่งจะประกอบไปด้วยข้อมูลสำหรับ 1 ตัวแปร โดยที่ข้อมูล 1 ค่าจะอยู่ในแต่ละแถว
หรือแต่ละเซลล์ วิธีการนี้จะจัดเรียงข้อมูลเหล่านั้นนำมาเรียงต่อกัน โดยกลุ่มของข้อมูลมาจากกลุ่มที่
แตกต่างกัน ยกตัวอย่างไฟล์ข้อมูลในตัวอย่างที่ 1.1 หากเราต้องการนำข้อมูลปริมาณของเสียในแต่ละวัน 
นำมาเรียงต่อกันในคอลัมน์เดียวกัน สามารถทำได้ดังนี้ 

- เข้าไปที่เมนู Data > Stack > Columns 

 

 

 

 

 

 

 

- คลิก OK ผลลัพธ์ที่ได้จากโปรแกรม 

 

 

 

 

คอลัมน์ที่ต้องการนำข้อมูลมาเรียง 

คอลัมน์ที่ต้องการแสดงผลลัพธ์ 

คอลัมน์ที่ต้องการแสดงที่มาของข้อมูล 
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- จะเห็นได้ว่าข้อมูลที่คอลัมน์ C8 คือข้อมูลที่นำมาเรียงต่อกัน ส่วนข้อมูลที่คอลัมน์ C9 แสดงที่มา
ของข้อมูลว่ามาจากคอลัมน์ไหน (เป็นข้อมูลประเภทข้อความ) 
 

• การนำเข้าข้อมูลจากไฟล์ Excel 

โปรแกรม Minitab สามารถรองรับไฟล์ข้อมูลจากโปรแกรม Excel ให้นำเข้ามาเปิดในโปรแกรม 
Minitab ได ้

- คลิก File > Open (เลือกไฟล์ Excel ช่ือ Defect no) 

 

 

 

 

 

 

- คลิก Open 

 

 

 

 

 

 

 

 

 

เลือกไดเร็กทอรี่ ที่จัดเก็บไฟล์ 

เลือกชื่อไฟล์ที่ต้องการเปิด 

เลือกชนิดของไฟล์ที่ต้องการ
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- ตรวจสอบความถูกต้องของข้อมูล แล้วคลิก OK ผลลัพธ์ที่ได้จากโปรแกรมแสดงดังรูป ซึ่งเป็น
ข้อมูลปริมาณของเสียที่เกิดข้ึนในวันเสาร์ และวันอาทิตย์น่ันเอง 

 

 

 

 

 

 

• การรวมเวิร์กชีตเข้าด้วยกัน 

เป็นการนำข้อมูลจากเวิร์กชีตหนึ่งไปรวมเข้าในคอลัมน์ของอีกเวิร์กชีตหนึ่ง 

- คลิก File > Open แล้วเปิดเวิร์กชีตช่ือ Defect no.mtw และ Defect no from Excel.mtw 
- คลิก Data > Merge Worksheets > Side by Side 

 
 
 
 
 
 
 
 
 
 
 

- คลิก OK ผลลัพธ์ที่ได้จากโปรแกรม โดยคอลัมน์ C1-C7 เป็นข้อมูลของเวิร์กชีตที่ 1 ส่วนคอลัมน์ 
C8-C11 เป็นข้อมูลของเวิร์กชีตที่ 2 จากนั้นสามารถใช้คำสั่งลบคอลัมน์ที่ไม่ต้องการออกได้ 

 

 

2 เวิร์กชีตที่ต้องการนำข้อมูลมารวมกัน 

ตั้งชื่อเวิร์กชีตใหม่ 
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1.6 เมนูช่วยเหลือ 

• Help 

เป็นเมนูที่ Minitab เตรียมไว้เพื่อให้คำแนะนำในการสนับสนุนการใช้งานของโปรแกรม 

- Help สำหรับการค้นหาข้อมูลในหัวข้อที่ผู้ใช้งานมีความสงสัย 
- Sample Data… สำหรับเปิดไฟล์ข้อมูลตัวอย่างที่ Minitab เตรียมไว้ให้ประกอบการเรียนรู้การ

ใช้งานโปรแกรม 
- Getting Started สำหรับแนะนำการใช้งานโปรแกรมเบื้องต้น ในฟังกชั์นพื้นฐานที่นิยมใช้ทั่ว ๆ 

ไป 
- About Minitab สำหรับการตรวจสอบ Product Key ของโปรแกรมที่ใช้งานอยู่ 

 

 

 

 

 

• Assistant 

เป็นเมนูที ่ Minitab เตรียมไว้เพื ่อให้คำแนะนำเทคนิคเฉพาะในการคำนวณ โดยจะมีฟังก์ชันการ
คำนวณที่มักจะถูกใช้งานเป็นประจำ เช่น การวิเคราะห์ระบบการวัด, การวิเคราะห์ความสามารถของ
กระบวนการ, กราฟ, การทดสอบสมมติฐาน, การวิเคราะห์ความถดถอย, การออกแบบการทดลอง, และ
แผนภูมิควบคุม เป็นต้น  
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บทที่ 2 การสร้างเครื่องมือคุณภาพ 
 

เครื่องมือคุณภาพ เป็นเทคนิคที่ใช้ในการวิเคราะห์เพือ่ช่วยในการทำความเข้าใจกับปัญหา และเป็นข้อมลูที่
สามารถนำไปใช้ในการแก้ไขปัญหาเพื่อการพัฒนาคุณภาพขององค์กร พัฒนาการผลิตหรือควบคุมคุณภาพใน
แต่ละกระบวนการได้อย่างถูกต้อง เครื่องมือเหล่านี้เป็นการรวบรวมและประยุกต์ใช้วิธีการทางสถิติ การใช้
หลักการทางด้านเหตุผลและศาสตรค์วามรู้ในด้านต่าง ๆ  มารวบรวม และเลือกใช้ในการจัดการกับปัญหาแตล่ะ
ชนิด 

โปรแกรม Minitab ช่วยอำนวยความสะดวกในการสร้างเครื่องมือคุณภาพต่าง ๆ เพื่อนำออกมาใช้ในการ
วิเคราะห์ข้อมูลได้อย่างถูกต้องในรูปแบบของกราฟในลักษณะต่าง ๆ ซึ่งในบทนี้จะกล่าวถึงการสร้างเครื่องมือ
คุณภาพด้วยโปรแกรม Minitab คือ แผนภาพจุด ฮิสโตแกรม  กราฟรูปกล่อง แผนภูมิ I-MR พล็อตอนุกรม
เวลา แผนภาพการกระจาย แผนภูมิพาเรโต และแผนภาพเหตุและผล  ในส่วนของแผนภูมิควบคุม ซึ่งถือว่า
เป็นเครื่องมือคุณภาพที่สำคัญนั้น จะขอกล่าวถึงโดยละเอียดในบทถัดไป 

2.1  ภาพรวมคุณภาพ 

ปัจจุบัน “คุณภาพ (Quality)” ได้เป็นกลไกหรือกุญแจสำคัญในการบริหารธุรกิจ ในหลายๆ องค์กรช้ันนํา 
“คุณภาพ” เป็นกลยุทธ์สำคัญขององค์กรเลยทีเดียว เพราะในปัจจุบันคําว่า “คุณภาพ” ไม่ได้หมายถึงการผลิต
หรือการบริการให้ได้ตามข้อกําหนด แต่ต้องสร้างความพึงพอใจให้กับลูกค้าทั้งภายนอก (External Customer) 
และภายใน (Internal Customer) การทำกิจกรรมเกี่ยวกับคุณภาพจะกระทบกับต้นทุนคุณภาพ (Cost of 
Quality) ดังนั้น การบริหารคุณภาพจึงต้องเป็นไปอย่างมีหลักการและประสิทธิภาพในยุคที่การแข่งขันสูงเช่น
ในปัจจุบัน 

มีคนให้คำนิยามของคำว่าคุณภาพไว้หลากหลาย เช่น ความเหมาะสมกับการใช้งาน (Juran, 1964) การ
เป็นไปตามความต้องการ หรือสอดคล้องกับข้อกำหนด (Crosby, 1979)  คุณภาพของการออกแบบและความ
สอดคล้องในการดำเนินงาน ที่จะนำมาซึ่งความภาคภูมิใจแก่เจ้าของผลงาน (Deming, 1940)  การประหยัด
ที่สุด มีประโยชน์ในการใช้งานสูงสดุ และสร้างความพึงพอใจใหก้ับลกูค้าอย่างสม่ำเสมอ (Ishikawa, 1985)  สิ่ง
ที่ดีที่สุดสำหรับเงื่อนไขด้านการใช้งาน และราคาของลูกค้า (Feigenbaum, 1961) หรือมาตรฐาน  ผลงาน 
ประสิทธิภาพ และความพอใจ (ทิพวรรณ, 2547)  

จากการศึกษาความหมายของคุณภาพที่ผู้เชี่ยวชาญกล่าวมา ผู้เขียนสรุปได้ว่า คุณภาพ หมายถึง การ
ดำเนินงานที่มีประสิทธิภาพเป็นไปตามข้อกำหนดที่ต้องการ โดยสินค้าหรือบริการนั้นสร้างความพอใจให้กับ
ลูกค้า และมีต้นทุนการดำเนินงานที่เหมาะสมได้เปรียบคู่แข่งขัน ลูกค้ามีความพึงพอใจ และยอมจ่ายตามราคา
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เพื่อซื้อความพอใจนั้น ซึ่งมิใช่เรื่องที่ประเมินจากสิ่งของที่จับต้องได้ หรือเป็นรูปธรรมเพียงด้านเดียว แต่จะต้อง
นำปัจจัยอื่น ๆ ที่เป็นนามธรรมมาประกอบการพิจารณาด้วย  

คุณภาพที่ดีประกอบไปด้วยลักษณะดังต่อไปนี้ 

1) ปฏิบัติงานได้ (Performance) ผลิตภัณฑ์นั้นต้องสามารถใช้งานได้ตามหน้าที่ที่กำหนดไว้ 
2) สุนทรียภาพ (Aesthetics) ผลิตภัณฑ์ต้องมีรูปร่าง ผิวสัมผัส สีสัน รสชาติที่ดึงดูดใจลูกค้า 
3) คุณสมบัติพิเศษ (Feature) ผลิตภัณฑ์ควรมีลักษณะพิเศษที่โดดเด่นแตกต่างจากคู่แข่ง 
4) ความสอดคล้อง (Conformance) ผลิตภัณฑ์ควรใช้งานได้ตามที่ลูกค้าคาดหวังไว้ 
5) ความปลอดภัย (Safety) ผลิตภัณฑ์ควรมีความเสี่ยงอันตรายในการใช้น้อยที่สุด 
6) ความน่าเช่ือถือ (Reliability) ผลิตภัณฑ์ควรใช้งานได้ทุกครั้งที่ต้องการ 
7) ความคงทน (Durability) ผลิตภัณฑ์ควรมีอายุการใช้งานที่ยาวนานในระดับหนึ่ง 
8) คุณค่าที่รับรู้ (Perceive Quality) ผลิตภัณฑ์ควรสร้างความประทบัใจ และมีภาพพจน์ที่ดีในสายตา

ลูกค้า 
9) บริการหลังการขาย (After sale service) ควรมีบริการหลังการขายอย่างต่อเนื่อง เพื่อให้สินค้า

ยังคงคุณภาพที่ดีในการใช้งานต่อไป รวมถึงการรับฟังความคิดเห็นของลูกค้าเกี่ยวกับผลิตภัณฑ์นั้นด้วย 

เครื่องมือคุณภาพ คือ เครื่องมือที่ช่วยวิเคราะห์ปัญหาคุณภาพโดยอาศัยหลักการทางสถิติเข้ามาช่วย
ในการวิเคราะห์ปัญหา หรือใช้ในการควบคุมกระบวนการ ซึ่งจะข้ึนอยู่กับสถานการณ์ว่าเครื่องมือใดจะ
เหมาะสม 

2.2  แผนภาพจุด (Dot Plot) 

เป็นการนำเสนอข้อมูลโดยใช้จุดแทนข้อมูลแต่ละกลุ่มเหนือเส้นในแกนนอน ที่มีสเกลตรงกับตำแหน่งของ
กลุ ่มที ่แสดงค่าของข้อมูลนั ้น Dot plot มีประโยชน์ในการแสดงตำแหน่งสัมพันธ์ของข้อมูล ช่วยให้เห็น
ภาพรวมของข้อมูลได้รวดเร็วกว่าการพิจารณาจากข้อมูลโดยตรง  โดยเฉพาะอย่างยิ่งเมื่อสนใจจะพิจารณา
ลักษณะของข้อมูลว่ามีการกระจายมากน้อยเพียงใด 

ตัวอย่างท่ี 2.1 การสร้าง Dot plot 

วิศวกรอุตสาหการของโรงงานผลิตเสื้อผ้าแห่งหนึ่ง ได้เก็บข้อมูลรอบเวลาการผลิตชิ้นงาน (Cycle 
time) ของพนักงาน 3 คน เพื่อนำมาวิเคราะห์หาเวลามาตรฐานในการทำงาน โดยทำการเก็บข้อมูล 50 ครั้งต่อ
พนักงานหนึ่งคน และเวลามีหน่วยเป็นวินาที (Minitab project: Quality, Worksheet: CycleTime) 

1. เข้าเมนู Graph > Dotplot > Simple  
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2. เลือกข้อมูล “Cycle Time” แล้วคลิก OK 

 

 

 

 

 

 

 รูปนี้แสดง Dot plot ของรอบเวลาการทำงานของพนักงานทั้ง 3 คนรวมกัน โดยแกนนอนจะแสดง
กลุ่มของข้อมูล แต่ละจุดเป็นตัวแทนของค่าที่ตกอยู่ในช่วงของกลุ่มข้อมูลนั้นๆ หากมค่ีาใดเกิดข้ึนซ้ำ จุดที่แสดง
ก็จะซ้อนทับกัน จาก Dot plot ทำให้ทราบช่วงของข้อมูลโดยประมาณ โดยค่าที่น้อยที่สุดอยู่ที่ 240 วินาที 
ส่วนค่าที่มากที่สุดอยู่ที่ 450 วินาที ดังนั้น ค่าพิสัย (Range) คือ 450-240 = 210 

 เนื่องจากเป็นข้อมูลรวมของพนักงาน 3 คน จึงยังไม่สามารถบอกได้ว่า ข้อมูลของพนักงานคนไหนที่
แตกต่างจากกลุ่ม หากต้องการดูการกระจายตัวของข้อมูลรายคน จะต้องสร้าง Dot plot ด้วยคำสั่ง Dot plot 
with groups  

1. เข้าเมนู Graph > Dotplot > With Groups  
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2. ในช่อง Graph variable เลือกข้อมูล “Cycle Time” ส่วนในช่อง Categorical variable for 
grouping เลือกข้อมูล “Associate” แล้วคลิก OK 
 

 
 

 

 

 

 

 

 จากกราฟ Dot plot จะแสดงผลข้อมูลคล้ายกับตัวอย่างก่อนหน้านี้ เพียงแต่ Dot plot with groups 
จะแยกข้อมูลตามพนักงานแต่ละคน 

 จากข้อมูลเราสามารถตั้งข้อสังเกตได้ว่า รอบเวลาการทำงานของ Somchai มีการกระจายตัวมากกว่า
ของคนอื่น และ Jittra มีรอบเวลาการทำงานต่ำกว่า Benjamas แต่ในการเปรียบเทียบค่าเฉลี่ยของสามกลุ่ม
ในทางสถิติน้ันต้องการการวิเคราะห์ที่ลึกซึ้งกว่าน้ี ซึ่งสามารถทำได้โดยการใช้วิธีการ ANOVA ซึ่งจะกล่าวถึงใน
บทถัดไป 
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2.3  ฮิสโตแกรม  (Histogram) 

ฮิสโตแกรม  เป็นการแสดงความถี่ของสิ่งที่เกิดขึ้นโดยแสดงเป็นกราฟแท่งสี่เหลี่ยมผืนผ้าที่มีความกว้าง
เท่ากันทุกแห่งและมีด้านข้างติดกันเป็นการสรุปเชิงกราฟของการแจกแจงความถ่ีของข้อมูล แสดงการแปรผัน
ในชุดข้อมูลที่นำมาจากกระบวนการผลิต ซึ่งแต่ละช่วงบนฮิสโตแกรม แสดงจำนวนค่าสังเกตทั้งหมดในแต่ละ
ช่วงแยกจากกัน 

ตัวอย่างท่ี 2.2 การสร้าง Histogram  

จากตัวอย่างเดิมของรอบเวลาการทำงานของพนักงานทั ้งสามคน (Minitab project: Quality, 
Worksheet: CycleTime) 

1. เข้าเมนู Graph > Histogram > Simple 
2. ในช่อง Graph variable เลือกข้อมูล “Cycle Time” แล้วคลิก OK 
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 ฮิสโตแกรม มีประโยชน์ในการวิเคราะห์การกระจายตัวของข้อมูล โดยค่าเริ่มต้นของ Minitab จะตั้งไว้
เป็นการแจกแจงแบบปกติ (Normal distribution) แต่ก็สามารถแสดงผลเป็นการแจกแจงข้อมูลแบบอื่น ๆ  ได้
ด้วย โดยใช้คำสั่ง Graph > Histogram > With Fit 

ในช่อง Graph variable เลือกข้อมูล “Cycle Time” แล้วคลิก Data View 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 คลิกที่แถบ Distribution แล้วเลือกการแจกแจงข้อมลูทีต่้องการ ในตัวอย่างนี้เลือกเป็น Normal (การ
แจกแจงแบบปกติ) หากทราบค่าพารามิเตอร์ต่าง ๆ  เช่น ค่าเฉลี่ย หรือ ค่าส่วนเบี่ยงเบนมาตรฐาน ก็ให้ใส่ใน
ช่อง Historical Parameters หากไม่ใส่ Minitab จะใช้วิธีการประมาณค่าพารามิเตอร์นี้จากกลุ่มตัวอย่างที่มี 

คลิก OK 

 

เลือกการแจกแจง

ท่ีต้องการ 
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 จะได้กราฟฮิสโตแกรม พร้อมเส้นโค้งแจกแจงแบบปกติ และค่าเฉลี่ย ค่าส่วนเบี่ยงเบนมาตรฐานที่ 
Minitab คำนวณให้ 

 หากต้องการกราฟฮิสโตแกรม ที่แสดงผลเปรียบเทียบรอบเวลาการทำงานของพนักงานทั้งสามคน 
สามารถทำได้ดังนี้ 

- เข้าเมนู Graph > Histogram > With Fit 
- ในช่อง Graph variable เลือกข้อมูล “Cycle Time” แล้วคลิก Multiple Graphs 

 
  

 

 

 

 

 

 

- จากนั้นคลิกแท็บ By Variables ในชอง By variables with groups in separate panels 

เลือกคอลมัน Associate แล้วคลิก OK 
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 จากกราฟฮิสโตแกรม จะเห็นการกระจายตัวของข้อมูลรอบเวลาการทำงานของพนักงานแต่ละคนเพื่อ
เปรียบเทียบกัน การตีความหมายของการกระจายตัวของข้อมูลจะเป็นไปในทิศทางเดียวกันกับแผนภาพจุด 
(Dot Plot) ในตัวอย่างที่ผ่านมา แต่ฮิสโตแกรม จะเห็นภาพได้ชัดเจนกว่าและสามารถบอกค่าพารามเิตอร์ที่
เกี่ยวข้องได ้

 นอกจากการแจกแจงแบบ Normal distribution แล้ว Minitab ยังมีการแจกแจงข้อมูลอีกหลายชนดิ
ให้เลือก ดังนี้ 

- Normal  
- Lognormal  
- 3-parameter lognormal  
- Gamma 
- 3-parameter gamma  
- Exponential  
- 2-parameter exponential  
- Smallest extreme value  
- Weibull  
- 3-parameter Weibull  
- Largest extreme value  
- Logistic  
- Loglogistic  
- 3-parameter loglogistic 
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2.4  กราฟรูปกล่อง (Box Plot) 

Box plot เป็นกราฟที่แสดงผลข้อมูลทางสถิติไปพร้อมกับแสดงการกระจายตัวของข้อมูลในรูปเดียว 
ค่าสถิติที่แสดงผลจะมี ค่าต่ำสุด ค่าสูงสุด ควอร์ไทล์ที่ 1 ควอร์ไทล์ที่ 3 (เท่ากับเปอร์เซ็นไทล์ที่ 25 และ 75 
ตามลำดับ ค่าเฉลี่ย (ควอร์ไทล์ที่ 2 หรือ เปอร์เซ็นไทล์ที่ 50) รวมทั้งข้อมูลที่อยู่ห่างจากกลุ่มมาก ๆ (Outlier)   

 

 

 

 

 

ตัวอย่างท่ี 2.3 การสร้าง Box plot  

จากตัวอย่างเดิมของรอบเวลาการทำงานของพนักงานทั ้งสามคน (Minitab project: Quality, 
Worksheet: CycleTime) 

1. เข้าเมนู Graph > Boxplot > Simple 
2. ในช่อง Graph variable เลือกข้อมูล “Cycle Time” แล้วคลิก OK 

 

 

 

 

 

 

 จากกราฟ Box plot จะเป็นข้อมูลของพนักงานทั้งสามคนรวมกัน สามารถแสดงการกระจายตัวของ
ข้อมูลและค่าทางสถิติที่สำคัญตามส่วนประกอบต่าง ๆ ที่ได้อธิบายไปก่อนหน้านี้ 

 ตำแหน่งรูปดอกจัน (*) ที่แสดงบนค่าสูงสุด (หรือบางกรณีอาจแสดงที่ตำแหน่งใต้ค่าต่ำสุด) คือ ข้อมูล
ที่แตกต่างจากกลุ่มมาก ๆ (Outlier) การมี Outlier ไม่ได้เป็นตัวช้ีวัดว่าข้อมูลกลุ่มนี้ดีหรือไม่ดี แค่เป็นตัวบอก

ตำแหน่งค่าสูงสุด 

ตำแหน่งควอร์ไทล์ท่ี 2 (ค่าเฉล่ีย) 
ตำแหน่งควอร์ไทล์ท่ี 1 

ตำแหน่งควอร์ไทล์ท่ี 3 

ตำแหน่งค่าต่ำสุด 

Outlier 
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ว่ามีข้อมูลที่แตกต่างจากค่าอื่นเท่านั้น แต่ต้องมีการไปตรวจสอบว่ากระบวนการเก็บรวบรวมข้อมูลมีความ
ถูกต้องหรือไม่     

 หากต้องการกราฟ Box plot ที่แสดงผลเปรียบเทียบรอบเวลาการทำงานของพนักงานทั้งสามคน 
สามารถทำได้ดังนี้ 

- เข้าเมนู Graph > Boxplot > With Groups 
- ในช่อง Graph variable เลือกข้อมูล “Cycle Time” ส่วนในช่อง Categorical variable for 

grouping เลือกข้อมูล “Associate” แล้วคลิก OK 

 

 

 

 

 

 

 

 

 

 

 
 

  

 

 

จะได้ Box plot ที ่แสดงเปรียบเทียบข้อมูลของพนักงานทั ้งสามคน ซึ ่งจะทำให้มองเห็นการ
เปรียบเทียบได้ชัดเจนมากข้ึน โดยข้อมูลของ Jittra มีการกระจายตัวน้อยกว่าพนักงานคนอื่น สังเกตได้จากรูป
กล่องสี่เหลี่ยมที่สั้นกว่าคนอื่น อีกทั้งค่าเฉลี่ยรอบเวลาการทำงานของ Jittra กต็่ำกว่าพนักงานคนอื่นอีกด้วย 
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2.5  แผนภูมิ I-MR (I-MR Chart) 

I-MR Chart (Individual Moving Chart) เป็นแผนภูมิที่ใช้ควบคุมค่าที่ได้จากการวัด และค่าการกระจาย
ของกระบวนการ โดยจะใช้ I-MR Chart ในกรณีที่ไม่สามารถเก็บข้อมูลเป็นกลุ่มได้ กล่าวคือ เก็บข้อมูลได้ครั้ง
ละ 1 ค่าเท่านั้น จึงไม่สามารถหาความแปรผันในกลุ่มตัวอย่างได้ ดังนั้น เมื่อจำเป็นต้องควบคุมกระบวนการ
ผลิต จะทำการสุ่มเพียงหนึ่งตัวอย่างเท่านั้น สถานการณ์แบบนี้อาจเกิดได้เนื่องจาก 

- การทดสอบแบบทำลายซึ่งมีค่าใช้จ่ายสูง 
- อัตราการผลิตเกิดขึ้นช้ามาก ๆ และไม่เหมาะสมที่เราจะใช้จำนวนตัวอย่างสุ่มมากกว่า 1 เพื่อ

สะสมข้อมูลก่อนสร้างแผนภูมิควบคุม ช่วงเวลาการผลิตระหว่างการสังเกตแต่ละค่าจะเป็นปัญหา
ถ้ามีการแบ่งเป็นกลุ่มตัวอย่าง 

- เมื่อผลิตภัณฑ์เป็นเนื้อเดียวกัน เช่น ความหนาของสารเคลือบผลติภัณฑ์ที่ถูกม้วนอยูใ่นลูกกลิง้ ทั้ง
ม้วนผลิตภัณฑ์มีความแตกต่างกันน้อยมาก 

- การตรวจสอบอัตโนมัติและเทคนิคการวัดค่าถูกนำมาใช้งานเมื่อทกุหน่วยผลิตจะต้องถูกตรวจสอบ 
ไม่มีการแบ่งเป็นกลุ่มย่อย ๆ 

ตัวอย่างท่ี 2.4 การสร้าง I-MR Chart  

จากตัวอย่างเดิมของรอบเวลาการทำงานของพนักงานทั ้งสามคน (Minitab project: Quality, 
Worksheet: CycleTime) 

1. เข ้ า เมน ู  Stat > Control Charts > Variables Charts for Individual > I-MR… จะปรากฏ
หน้าต่าง Individuals-Moving Range Chart  

 

 

 

 

 

 

 

2. ในช่อง variable เลือกข้อมูล “Cycle Time” แล้วคลิก OK 
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 เส้นกลางของแผนภูมิควบคุม คือเส้นค่าเฉลี่ยของข้อมูล ส่วนเส้นบนและเส้นล่าง คือ เส้นควบคุม
ขอบเขตบนและเส้นควบคุมขอบเขตล่าง ตามลำดับ ข้อมูลที่อยู่นอกเส้นควบคุมนี้จะถือว่ามีความเป็นไปไดท้ี่
ข้อมูลกลุ่มนีม้ีความผิดปกติเกิดข้ึน และกระบวนการนี้ไม่อยู่ในการควบคุม 
 จาก I-MR Chart จะเห็นได้ว่ามีจุดที่ออกนอกเส้นควบคุม แสดงถึงความแตกต่างของข้อมูลกับข้อมูล
ก่อนหน้าว่ามีความแตกต่างกันมาก จึงต้องมีการพิจารณาข้อมูลในจุดน้ีเพิ่มเติม  
 รายละเอียดของเรื่องแผนภูมิควบคุมจะกล่าวถึงเชิงลึกในบทถัดไป 

2.6  พลอ็ตอนุกรมเวลา (Time Series Plot) 

อนุกรมเวลา เป็นการเก็บรวบรวมข้อมูลเชิงตัวเลขของตัวแปรหนึ่งตามลำดับเวลาที่ทำการเก็บรวบรวม
ข้อมูล การวิเคราะห์อนุกรมเวลาทำให้เราทราบแนวโน้มของข้อมูลที่เปลี่ยนไปตามเวลานำไปสู่การประยุกต์ใช้
ในการพยากรณ์เชิงปริมาณต่อไป 

ตัวอย่างท่ี 2.5 การสร้าง Time Series Plot 

จากตัวอย่างเดิมของรอบเวลาการทำงานของพนักงานทั ้งสามคน (Minitab project: Quality, 
Worksheet: CycleTime) 

1. เข้าเมนู Graph > Time Series Plot > Simple จะปรากฏหน้าต่าง Time Series Plot   
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2. ในช่อง Series เลือกข้อมูล “Cycle Time” แล้วคลิก OK 

 

 
 

 

 

 

 

 จากกราฟ Time Series Plot แสดงให้เห็นข้อมูลรอบเวลาการทำงานของพนักงานทั้งสามคนมีแนวโน้ม
เพิ่มมากขึ้น โดย Minitab จะประมวลผลข้อมูลตามลำดับก่อน-หลัง ที่เราเลือกไว้ คือ Jittra, Somchai และ 
Benjamas ในการแสดงผลข้อมูลของแต่ละพนักงานสามารถทำได้ดังนี้  

- คลิกขวาที่กราฟ แล้วเลือก Edit Graph  
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- คลิกขวาที่สัญลักษณ์ของข้อมูล เลือก Edit Symbols แล้วกด OK 

 

 

 

 

 

 

 

- จะปรากฏหน้าต่าง Edit Symbols เล ือกที ่แถบ Group ในช่อง Categorical variables for 
grouping เลือกข้อมูล Associate แล้วกด OK 
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กราฟ Time Series Plot แสดงข้อมูลของพนักงานแต่ละคนแยกตามสี จะเห็นได้ชัดเจนว่าสาเหตุที่
ข้อมูลมีแนวโน้มเพิ่มข้ึนเพราะข้อมูลมาจากพนักงานที่แตกต่างกันนั่นเอง 

ตัวอย่างท่ี 2.6 การสร้าง Time Series Plot 

จากข้อมูลราคาหุ้นของสองบริษัท คือ บริษัท A และ บริษัท B ซึ่งได้จากการเก็บข้อมูลทุกเดือนเริ่ม
ตั ้งแต่เดือนมีนาคม เป็นระยะเวลา 24 เดือน จงสร้าง Time Series Plot (Minitab project: Quality, 
Worksheet: StockPrice) 

เดือนท่ี บริษัท A (บาท) บริษัท B (บาท) 
1 36.25 30.00 
2 37.25 31.13 
3 37.75 29.63 
4 38.25 29.75 
5 39.88 34.25 
6 40.88 32.13 
7 39.13 30.88 
8 40.00 39.13 
9 41.50 42.38 
10 38.63 35.88 
11 40.13 32.00 
12 41.88 46.13 
13 40.50 42.88 
14 42.75 47.50 
15 42.88 49.25 
16 42.50 46.50 
17 41.13 45.25 
18 43.50 54.88 
19 42.88 48.88 
20 43.75 56.25 
21 44.00 60.13 
22 44.50 56.88 
23 43.88 59.75 
24 45.50 60.25 
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1. เข้าเมนู Graph > Time Series Plot > Multiple ปรากฏหน้าต่าง Time Series Plot  ในช่อง 
Series เลือก Company A และ Company B แล้วคลิก Time/Scale 

 

 

 

 

 

 

2. ในแถบ Time เลือก Calendar แล้วเลือก Month ส่วนในช่อง Month ให้ใส่เดือนที ่เริ่มเก็บ
ข้อมูล จากนั้นกด OK 
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 จาก Time Series Plot พบว่าราคาหุ้นของบริษัท B มีแนวโน้มเพิ่มขึ้นมากกว่าบริษัท A ในช่วง 6 
เดือนที่ผ่านมา แตร่าคาหุ้นของบริษัท B จะมีความผันผวนมากกว่า (ข้ึนแรง - ลงแรง) และราคาหุ้นของบริษัท 
B ต่ำกว่าบริษัท A ในช่วงเริ่มต้น แต่หลังจากเดือนเมษายนเป็นต้นไป ราคาหุ้นของบริษัท B ก็สูงกว่ามาโดย
ตลอด 

2.7  แผนภาพการกระจาย (Scatter Plot) 

แผนภาพการกระจาย (Scatter Plot) ใช้หาความสัมพันธ์ระหว่างตัวแปร 2 ตัว โดยการลงค่าเป็นจุดแบบ
กระจัดกระจายบนกราฟ แต่ละจุดในแผนภาพการกระจายคือ ค่า x และ y เป็นคู่ ๆ Scatter Plot ที่สร้าง
เสร็จแล้วจะสามารถสรุปความสัมพันธ์ระหว่าง 2 ตัวแปรได้ โดยมีรูปแบบความสัมพันธ์ 6 รูปแบบ ดังรูป 

 

 

 

 

 

 

 

 

 

- รูปแบบ (ก) ตัวแปร x และ y มีความสัมพันธ์กันเชิงบวก ตัวแปรทั้ง 2 ตัว แปรผันตามกันโดยที่ x 
เพิ่ม y ก็จะเพิ่มตาม 

- รูปแบบ (ข) เป็นรูปแบบที่อาจจะมีหรือไม่มีความสัมพันธ์กันระหว่างตัวแปร x และ y แต่ถ้ามี
ความสัมพันธ์กัน จะเป็นความสัมพันธ์เชิงบวกต่อกัน 

- รูปแบบ (ค) ตัวแปร x และ y ไม่มีความสัมพันธ์กันเลย 
- รูปแบบ (ง) เป็นรูปแบบที่อาจจะมีหรือไม่มีความสัมพันธ์กันระหว่างตัวแปร  x และ y แต่ถ้ามี

ความสัมพันธ์กัน จะเป็นความสัมพันธ์เชิงลบต่อกัน 
- รูปแบบ (จ) ตัวแปร x และ y มีความสัมพันธ์กันเชิงลบ ตัวแปรทั้ง 2 ตัว แปรผกผันกันโดยที่ x 

เพิ่ม y ก็จะลดลง 
- รูปแบบ (ฉ) ตัวแปร x และ y มีความสัมพันธ์กันในเชิงเส้นโค้งมากกว่าเส้นตรง 

(ก) ความสัมพันธ์เชิงบวก (ข) ความสัมพันธ์เชิงบวก
แบบแอบแฝง 

(ค) ไม่มีความสัมพันธ ์

(ง) ความสัมพันธ์เชิงลบแบบ
แอบแฝง 

(จ) ความสัมพันธ์เชิงลบ (ฉ) ความสัมพันธ์แบบเส้นโค้ง 
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ตัวอย่างท่ี 2.7 การสร้าง Scatter Plot 

วิศวกรโรงงานต้องการศึกษาความสัมพันธ์ระหว่างเวลาในการซ่อม กับค่าใช้จ่ายในการซ่อมว่ามี
ความสัมพันธ์กันหรือไม่ โดยนําข้อมูลทั้งหมด 220 ข้อมูลในอดีตมาทำการวิเคราะห์ จงสร้าง Scatter Plot 
(Minitab project: Quality, Worksheet: FixMC) 

1. เข้าเมนู Graph > Scatter Plot > Simple ปรากฏหน้าต่าง Scatterplot และป้อนคอลัมน์ใน
ไดอะล็อกบ็อกซ์ดังต่อไปนี้ 

 

 

 

 

 

 

 * ข้อควรระวัง: ควรระบุตัวแปรต้น (x) และตัวแปรตาม (y) ให้ถูกต้อง ในตัวอย่างนีเ้นื่องจากค่าใช้จ่าย
ในการซ่อมจะข้ึนอยู่กับเวลาในการซ่อม ดังนั้น เวลาในการซ่อมจึงเป็นตัวแปร x ส่วนค่าใช้จ่ายในการซ่อมเป็น
ตัวแปร y  

2. คลิก OK จะได้ผลกราฟ 
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จากกราฟยังไม่เห็นความสัมพันธ์ที่ชัดเจนระหว่าง 2 ตัวแปร แต่หน่วยซ่อมบํารุงแบ่งทีมทำงาน
ออกเป็น 3 ทีม ประกอบด้วย A, B และ C หากต้องการตรวจสอบความสัมพันธ์ด้วยว่าแต่ละทีมให้ผล
สอดคล้องกันหรือไม ่สามารถทำได้โดยใช้คำสั่ง Scatter With Groups 

- เข้าเมนู Graph > Scatter Plot > With Groups ปรากฏหน้าต่าง Scatterplot และป้อน

คอลัมน์ในไดอะล็อกบอ็กซ์ดงัต่อไปนี ้โดยในช่อง Categorical variables for grouping ให้ป้อน

คอลัมน ์Team 

 

 

 

 

 
- คลิก OK จะได้ผลกราฟ 
 
 
 
 
 
 
 
 
 
 
 

จากกราฟที่ได้จะแสดงผลตามแต่ละหน่วยซ่อมบํารุง แต่ลักษณะกราฟยังกระจัดกระจายแสดงวา่แต่
ละทีมไม่ได้มคีวามแตกต่างอย่างชัดเจน และยังไม่เห็นความสัมพันธ์ระหว่างเวลาในการซ่อมกับต้นทุนในการ
ซ่อมอย่างชัดเจน 
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ตัวอย่างท่ี 2.8 การสร้าง Scatter Plot 

ฝ่ายซ่อมบำรุงของโรงงานแห่งหนึ่งทำการศึกษาความสัมพันธ์ระหว่างอุณหภูมิกับค่าความหนืดของ
น้ำมัน โดยทำการบันทึกค่า 33 ข้อมูลมาเพื่อทำการศึกษา จงสร้าง Scatter Plot (Minitab project: Quality, 
Worksheet: Viscosity) 

1. เข้าเมนู Graph > Scatter Plot > Simple ปรากฏหน้าต่าง Scatterplot และป้อนคอลัมน์ใน
ไดอะล็อกบ็อกซ์ดังต่อไปนี้ 

 

 

 

 

 

 

2. คลิก OK จะได้ผลกราฟ 

 
 
 
 
 
 
 
 
 
 
 

จากกราฟที่ได้ แผนภาพการกระจายแสดงความสัมพันธ์เชิงลบ คือเมื่ออุณหภูมิสูงข้ึน ค่าความหนืดจะ
มีแนวโน้มลดลง แต่ในช่วงปลายๆ ความสัมพันธ์จะมีการกระจายมากข้ึน 
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2.8  แผนภูมิพาเรโต (Pareto Chart) 

แผนภูมิพาเรโต คือ กราฟแท่งของข้อมูลชนิดต่าง ๆ  ที่นํามาเรียงกันโดยให้กราฟแท่งของข้อมลูทีม่ีค่าสงูสดุ
อยู่ทางซ้ายและเรียงตามลำดับมาทางขวามือตามค่าที่ลดลง เพื่อใช้เปรียบเทียบลำดับความสำคัญหรือปริมาณ
ของปัญหาระหว่างข้อมูลชนิดต่าง ๆ  อัลเฟรโด พาเรโต (พ.ศ. 2391 - 2466) เป็นนักเศรษฐศาสตร์ชาวอติา
เลียน ได้แสดงผลการวิจัยของเขาซึ่งแสดงให้เห็นถึงการกระจายรายได้ของประชากรในยุโรป พบว่ารายได้มาก
อยู่ในมือของประชากรกลุ่มน้อย ขณะที่รายได้น้อยอยู่ในมือของประชากรกลุ่มใหญ่ 

การตัดสินใจในหลักการพาเรโต (Pareto Principle) คือ “80-20” ซึ่งหมายความว่า “ปัญหาหรือความ
สูญเสียที่มีความสำคัญมากจำนวน 80% มักจะมีสาเหตุมาจากประมาณ 20% ของสาเหตุทั้งหมด ในขณะที่อีก
ประมาณ 80% ของสาเหตุ จะมีผลต่อปัญหาที่มีความสำคัญเพียงเล็กน้อยอีกจำนวน 20% ของปัญหาเท่านั้น 
เช่น ยอดขายกว่า 80% เกิดจากยอดสั่งซื้อเพียงไม่กี่บัญชี เป็นต้น  

ในโรงงานอุตสาหกรรมมีปัญหาเป็นจำนวนมากที่ไม่ทราบว่าควรจะแก้ไขอย่างไร เริ่มต้นตรงไหนดี หรือ
กล่าวอีกนัยหนึ่ง ไม่ทราบจะปรับปรุงโรงงานให้ดีขึ้นได้อย่างไร การนําแผนภูมิพาเรโตมาใช้ในการวิเคราะห์
ปัญหาจะช่วยทำให้สามารถแก้ไขปัญหาได้อย่างตรงเป้าหมายและรวดเร็ว 

ดังนั้นแผนภูมิพาเรโตจะเป็นเครื่องมือที่ชี้ให้เห็นถึงว่า ปัญหาสำคัญจริง ๆ นั้นมาจากไม่กี่สาเหตุ และ
ปัญหาที่มีความสำคัญน้อยเกิดจากสาเหตุมากมาย สรุปว่าในการแก้ปัญหาไม่จำเป็นต้องแก้ทุกสาเหตใุห้หมด 
แต่ให้เลือกแก้เฉพาะสาเหตุหลักที่สำคัญ กล่าวคือ ปัญหาใดเป็นปัญหาสำคัญมากก็ควรเร่งแก้ไขก่อน และ
ปัญหาใดที่เป็นปัญหาสำคัญน้อยก็ให้แก้ไขทีหลัง  

ตัวอย่างท่ี 2.9 การสร้าง Pareto Chart 

แผนกซ่อมบํารุงต้องการศึกษาความถ่ีของประเภทสัญญาณที่แจ้งให้ส่งพนักงานแผนกซ่อมบํารุงลงไป
ทำการแก้ไข ทางแผนกนําข้อมูลตลอดหนึ่งปีที่ผ่านเพื่อสร้างแผนภูมิพาเรโตเพื่อศึกษาว่าสัญญาณแจ้งประเภท
ใดมีความถ่ีมากที่สุด จงสร้าง Pareto Chart (Minitab project: Quality, Worksheet: Alarm) 

1. เข้าเมนู Stat > Quality Tools > Parato Chart ปรากฏหน้าต่าง Parato Chart และป้อนคอลัมน์
ในไดอะล็อกบ็อกซ์ดังต่อไปนี้  

 

 

 

 


